Panasonic

Multimedia Quad Speed
CD-ROM Sound Player

Model No. KXL'D745

Operating Instructions

Please read before using and store in a safe place



Thank you for purchasing the Panasonic Multimedia QGuad Speed CD-ROM
Sound Player KXL-D745.

4 WARNING I

e The power source voltage of the AC adaptor is listed on the nameplate.
Plug the AC adaptor only into an outlet with the proper voltage.

eTo prevent fire or shock hazard, do not expose this product to rain or any type

\_ of moisture. ) J

4 CAUTION N

*When you operate this equipment, the mains socket-outlet should be near
the equipment and should be easily accessible.

eTo prevent the SCSi interface connector from static electricity damage,

before you touch it, discharge any static electricity from your hands by

touching a grounded metal surface, such as the screw on the plate cover of

k an electrical outlet. J

4 CAUTION FOR LASER )
This product utilizes a laser.

Use of control, adjustment or performance of procedures other than those
specified herein may result in hazardous radiation exposure.

Do not open covers and do not repair yourself. Refer servicing to qualified
perscnnel,

Laser diode properties

Material GaAlAs
Laser output Lessthan 52.65 yW
Wave length 790 nm

Emission duration Continuous

(This output is the value measured at the distance of 200 mm from the
Kobjective lens surface.) Y,




~———— FORUSERS IN UNITED STATES ONLY

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation.

This equipment generates, uses and can radiate radio frequency energy and,
if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interferance by one or more of
the following measures:

eReorient or relocate the receiving antenna.

s|Increase the separation between the equipment and receiver.

eConnect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

e Consuit the dealer or an experienced radio/TV technician for help.

The user may find the booklet “Something About Interference” available from
FCC local regional offices helpful.

FCC Warning: To assure continued FCC emission limit compliance, the user
must use only the recommended shield interfacing cable when connecting to a
host computer. Also, any unauthorized changes or modifications to this equip-
\ment would void the users authority to operate this device. Y.




(" FOR USERS IN CONTINENTAL UNITED STATES ONLY

Technical Support and Service Parts Calls

If you have read this manual and tried the troubleshooting procedures, and you
are still having difficulty, please contact the store from which the unit was
purchased. Panasonic Communications & Systems Company will repair this
product with new or refurbished parts free of charge for two (2) years from the
date of purchase.

You may also call the technical support telephone number {24 hours/7 days).

The technical support number is: 1-800-PANA-SYS
(1-800-726-2797)
The service parts number is: 1-800-332-5348

N /
/The serial number of this unit may be found on the label located at the bottom\

of the unit. Write this number below and keep this book along with your proof
of purchase to serve as a permanent record of your purchase or for future
reference.

MODEL NO. KXL-D745 NAME OF DEALER

SERIAL NO. DATE OF PURCHASE

__/

IBM is a trademark of International Business Machines Corporation.

Microsoft®, Windows® and MS-DOS® are registered trademarks of Microsoft Corporation
in the United States and/or other countries.

Photo CD is a trademark of Eastman Kodak Company.

Sound Blaster is a trademark of Creative Technology Lid.

AudioDrive is a trademark of ESS Technology, Inc.

All other brands and product names are trademarks or registered trademarks of their
respective companies.

Microsoft MS-DOS® CD-ROM Extensions Copyright © Microsoft Corporation.
1986-1993, All rights reserved.

Any details given in these Operating Instructions are subject te change without notice.
Copyright © 1994, by ESS Technology, Inc. All rights reserved.

All Rights Reserved, @ COPYRIGHT 1996 KYUSHU MATSUSHITA ELECTRIC CO.,
LTD.
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B Features:

® Quad Speed External Drive {(Max. 600 KB/s).

¢ Supports CD-ROM, CD-ROM XA, CD-DA, Photo CD Multisession,
CD-1*', VIDEQ CD *'.

® Sound Biaster FM Sound Source for Windows and DOS Ad-Lib Compat-
ible.

* YAMAHA OPL3 Compatible FM Music Synthesizer.

® Recording & Playback up to 44.1 kHz CD Quality Stereo Sound.

e Includes a variety of Sound System Utilities for Windows 3.1, 3.11.
® Stereo speakers are built into CD-ROM player.

e Use as a Personal Audio CD Player with built-in speakers or Head-
phones (not included) (w P. 29).

e Operates on Lightweight AC Adaptor, Six (6) “AA” size Batteries (not
supplied) or Optional Rechargeable Battery (Ni-Cd) (& P. 11~14).

e Can be connected to a notebook/desktop computer which has PCMCIA
card slot with supplied Sound/CD-ROM Interface Card and Interface
cable (= P. 15, 17).

e Can be connected to a desktop computer with purchase of SCSI board
and SCS! cable * (& P. 17).

e Both CD-ROM and audio CD can be played when attached to your
computer (i P. 28),

& Compatible with Windows 95, Plug and Play PCMCIA Interface Card
(Typell).

®SCSI-2 Software Command Compatible.

*I ' When using CD-l or VIDEO CD, commercial MPEG Boards are required on the
computer side.

*2 Audio data (WAVE and MIDI, etc.), except for CD-DA data, cannot be played back
through the built-in speakers when connected to a desktop computer with a SCSI
board installed. If you install the Sound board onto the computer, you can listen to
audio data through the Line-out jack of the Sound board.

Important:
B Piease use CD-ROMs B Please use audio CDs
with the marking below. with the marking below.

WISE uisE
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Precautions

player.

#[o not scratch or
smudge the surface of
CD.

*[o not place heavy
objects on the player.

¢Do not shake or subject
to intense vibration.

Do not expose the
player to direct sunfight
or heat. Especially do
not leave it in a hot
automobile.

the player.
Do not spill liquid.

Do not touch the lens.

®Keep disc cover closed to protect from dust.
#Do not play CD-ROM/audio CD while transporting.
#Do not use near any appliance that may cause vibration,

Accessories

Make sure that the following accessories are included with the player.

Sound/CD-ROM Interface cable AC adaptor  Setup disk  Microphone
Interface Card (& P. 15) (KX-WZ322) (@ P.19) (& P.16)
(& P. 15) @@ P.11)

[The shape may
differ from the product.]

sWarranty card

#Qperating instructions




Part Names

Disc cover (& P. 27)

Lock switch (@& P. 27)
Locks the disc cover by
sliding the Lock switch
toward the rear of the
player.

OPEN button (= P. 27)
Opens the disc cover.

Display (= P. 10)

VOLUME control (&= P. 29}
Adjusts the volume of the
built-in speakers or
headphones (not supplied)
connected to the PHONES
jack (0~10).

* Built-in speakers (& P. 28, 29)

POWER switch (& P. 18)
Turns the power on/off.

#l {STOP button) (& P. 29)
Stops playing audio CD.

w1 (Forward skip button)
wr P. 29)
kips to the next track(s).

q
~
74

—— LINE IN jack (= P. 16)
Connects to the Line-out jack
of an audio device by using a
commercially available audio
connecting cable.

MIC jack (= P. 16)
Connects the supplied
microphone for voice or
music recording.

L PHONES jack (= P. 28, 29)
Connects your headphones

M I1/CHG
(PLAY/PAUSE/CHARGE button)
Starts/pauses playing audio CD
(& P. 29) or charges the
optional rechargeable battery by
pressing this button (& P. 12).

{not supplied).

I+« (Reverse skip button) (= P. 29)
Skips to the previous track(s}

or returns to the beginning of

the track being played.

Rear/Bottom view

Battery cover
{w P. 11, 14)

DC IN jack
= P.11)

SOUND interface
connector (& P. 15)

DIP switch (=& P. 59)
Sets the SCSI (D number.
Sets the terminator ON or OFF.

RESET switch (= P. 53)
Resets the player.

SCSl interface connector
(= P.15)

| 1a1dey)
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Part Names

Display messages

Message/Indication Description
With a CD-ROM inserted in the player, if you press
. L] L] -0 AHG
-AUDIO DISC ONLY- O , O O o (2 blinking message
“AUDIQ DISC ONLY” appears,
When data is being transtferred, a blinking message
BUSY “BUSY"” appears.

CD is not inserted, or the inserted CD is not recognized

nodisl because either the CD is placed with the labe! side facing
down, or it is damaged, dirty, wet, etc.
When CD-BOM is inserted, a message “on” is displayed.

an While CD-ROM or audio CD is recognizing, a blinking
message “on” appears.
Audio CD is recognized.

ni nnnn

Uil uuud
The disc cover is open.

GPETN
When the battery is low, this blinking indication appears.
AN
This blinking indication appears while the rechargeable
[ HL4=]] | battery (option) is being charged.

10




Power Supply

The supplied AC adaptor, rechargeable battery (option) or Alkaline batteries (not supplied)

can be used for power source of the player.

Using supplied AC adaptor

- AC
outlet
20V

DC IN jack

Using rechargeable battery (option)

Optional rechargeable battery (KX1-D30) needs to be purchased. Before initial use,
please charge the rechargeable battery (= P. 12).

Note:

eWhen using the rechargeable battery, the data transfer rate may decrease and the

access time may increase.

Connect one end of the AC adaptor
to DC IN jack and the other end to
household AC outlet.

Caution:

eUse only the supplied AC adaptor
{KX-WZ322), since other adaptors
may damage the player.

Installing rechargeable battery

Make sure the player is off.

Rechargeable
battery

Player ©l

connector % Battery cover

Ribbon

the: 7

@ Open the battery cover by sliding
and lifting it up.

@ Insert the rechargeable battery
connector into the player connec-

tor {(@).

© Install the rechargeable battery
{(©) placing the ribbon under-
neath it and pressing the springs

(®)-

O Close the battery cover by press-
ing it down and sliding it back.

olf the player is not going to be used for more than two {2) months, remove the
rechargeable battery to maintain the battery life.

11
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Power Supply

Charging rechargeable battery

Charge the rechargeable battery:
eBefore initial use.
#®When the blinking mark “ EE appears on the players display.

Caution:
sDo not charge the rechargeable battery using a charger other than this player.

Install the rechargeable battery (= P. 11 “Installing rechargeable
battery™).

Connect the supplied AC adaptor (& P. 11),

Turn on the player by pressing the POWER switch (= P. 18).

=N CHG

Press [} on the player until the mark “ 7#,<< ™ appears.

Charging starts and it will complete automatically when the mark “ /#4<3”
disappears and the power goes off. A full battery charge requires a maximum of
three (3} hours.

¢ To stop charging, turn off the power.

2 wWN =

Notes:

s While charging no operation can be performed.

slf you charge the rechargeable battery under extremely low or high temperature,
the charging capacity may reduce. Please charge the rechargeable battery within
an appropriate temperature range of 5°C to 35°C.

#|f the blinking mark “cm " appears while using the rechargeable battery with the
computer attached, connect the AC adaptor. Otherwise the computer may not
funclion properly.

B Supplemental charging function:

Charging starts automatically when the rechargeable battery is installed, the AC adapter is
connected and the power is on. While being charged no mark appears on the player's
display.

In this case, a full charge may not be done. To charge the rechargeable battery fully, follow
the steps 1 to 4 above.

12



Power Supply

Refreshing rechargeable battery

If the rechargeable battery seems lo run down socner than usual (maybe because of
repetitive shoert-term charging and discharging), refresh the rechargeable battery two to
three times by following the instructions below.

) s91deyd

1. Disconnect the AC adaptor.
2. Play an audio CD repeatedly until the blinking mark * EIE " appears and the power
goes off.
sWhen all music finish playing, power will go off. Turn the power on and play an
audio CD again. i
3. Connect the AC adaptor, turn on the player and press (_Jon the player until the
mark “L#4 1 " disappears.
4, Charge the rechargeable battery until the mark “ /4 <3 " appears and the power
goes off.

Replacing rechargeable battery (option)

Replace the rechargeable battery:
o|f the rechargeable battery quickly runs down even after refreshing (it has reached
the end of its life).

Note:
oThe rechargeable battery will charge approximately 300 times under optimum
condition.

B Removing the rechargeable battery:
@ Open the battery cover.
@ Pull the ribbon upward.

© Disconnect the rechargeable
battery connector by pulling its
cable carefully, then remove the
rechargeable battery.

Rechargeable}¥ ] O Close the battery cover.
battery W

connector

Aapeq ojqeabieyosas Buroeiday ‘Buiysaljey ‘Buibieyn

Ribbon
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Power Supply

Using alkaline batteries (not supplied)

Six (6) “AA’ size alkaline batteries are required.

Alkaline battery Precautions:

If improperly used, the batteries may leak and cause corrosion. Therefore, observe the
following:

#|nstall batteries according to the diagram.

# Do not mix old and new batteries, or carbon and alkaline battery types.

sRemove all batteries when not using the player for extended periods.

Do not charge, short-circuit, disassemble, heat, or dispose of in fire.

Battery cover @ ) _a O O e aery cover by sliding
EL W and lifting it up.

@ Install six “AA” size batteries
(not supplied) placing the ribbon
underneath them.

Make sure the polarities (+, —) maich
the diagram.

© Close the battery cover.

Replace the batteries when blinking
mark ** :N ” appears on the
display.

Notes:

eWhen using the alkaline battery, the data transfer rate may decrease and the access
time may increase.

o|f the blinking mark “ " appears while using the alkaline battery with the
computer attached, connect the AC adaptor. Otherwise the computer may not
function properly.

14



Connection

Connecting player to a notebook computer

Note:
®Use only the supplied Sound/CD-ROM Interface Card and Interface cable.

9]
=
o
o
—
D
=
b

Make sure that your notebook computer and the player are off and the player’s
terminator is set to ON (= P. 59).

1 Connect the cable (" » T4 " mark facing up) to
the Sound/CD-ROM Interface Card.

Connect the cable to the player’s

@ SCSl interface connector.

Connect the cable (“«" mark
facing up) to the player’s
SOUND interface connector.

4 Insert the Sound/CD-ROM Interface Card
(*Panasonic” side facing up) to the PCMCIA card
slot until it stops.

2 1aydeyd

Note:

& On some computers you might have to insert the card with
the “Panasonic” side facing down. The card is keyed so
it can only be installed in the correct direction.

B Disconnecting Sound/CD-ROM Interface Card:
Pull the Interface cable while press-

Jaindwon yoogajou e 0} Bunsauuon/sauraneq auleyie buisn

Tabs ing the side tabs of the Interface
cable.
Caution:
2} ¢Do not force the Interface cable,
since this can damage the card or
y cable.

@ Interface cable

15



Connection

Connecting the microphone

The supplied microphone can be used to make recordings of voices or other acousticai
audio sources. For the detailed operation, refer to the “Audio Applications Operation”
{=Fr P.30~49).

Caution:
elJse only the supplied microphone, otherwise proper operation is not guaranteed.

Note:
e Speakers may howl depending on the setting of the audio application. Please lower
the player's VOLUME control or the MIC volume (& P. 26, 33, 49).

Connect the microphone to
the MIC jack of the player.

Connecting an audio connecting cable (not supplied)

When you wish to listen tofrecord the sound which comes out of the Line-out jack of an
audio device, connect a commercially available audio connecting cable.

Note:

*Whenever you connect/disconnect an audio connecting cable, be sure that the
volume of the player is set to the lowest level.

1 Connect one end of the audio connecting cable
to the Line-out jack of an audio device.

2 Connect the other end of the
audio connecting cable to the

16 LINE IN jack of the player.



Connection

Connecting player to a desktop computer

If your desktop computer has a PCMCIA card slot, you can connect the player to the
computer by using the supplied Sound/CD-ROM Interface Card and Interface cable. Refer
to “ Connecting player lo a notebook computer” { P. 15).

Installing SCSI board (not supplied) onto a
desktop computer

SCSI board and SCSI cable*' are required.

For further information, refer to your SCSI board manual.

Panasonic recommends either an Adaptec AHA-1542C or Future Domain TMC-1670, etc.
The SCSI board must be "ASPI" compatible.

Z sa1dey)d

Note:

e Audio data (WAVE and MIDI, etc.), except for CD-DA data, cannct be played back
through the built-in speakers when connected to a desktop computer with a SCSI
board installed. If you install the Sound board onto the computer, you can listen to
audio data through the Line-out jack of the Sound board.

00

2s

SCSi board 23
00

=

33

Qo

[l

o

o ®

o3

oS

B9

SCSI cable*” SCSl interface connector 38
L=

=

Cautions: 8 S
* elUse a shielded SCS! cable of 1.5 m (4.9 ft.) or shorter. _g »
®Plug half-pitch or full pitch end of SCSI cable inte computer and the half-pitch < &
end into the player. 29
0

a

g

e

M Daisy chain connection:

You can connect this player to other SCSI| devices {up to seven devices). Make sure that
each SCSi device has different SCSI ID number,

For setting the SCSI ID number and terminator of this player, refer to “SCSI ID Number
and Terminator” (& P. 59).

17



Power On

Turn on the player by pressing the POWER switch, and then turn on the computer.

A blinking message “on” appears on the display of the player.

Power switch

#To turn off the player, press the POWER switch again.
The display message(s) will disappear.

Note:

elf the player is not going to be used for an extended period, unplug the AC adaptor
from both the player and AC outlet to save power consumption. (Approximately
2.5 W power is consumed when the player is OFF and the AC adaptor is connected.}

B Power Save Function (except when charging the optional
rechargeable battery):

The player enters the Sleep Mode under the following conditions to save power.

sWhen using with computer, and no command is sent to the player from the computer for
more than 4 minutes.

s\When using the player independently, CD is not being played, and no button of the player
is pressed for more than 4 minutes.

During the Sleep Mode, the laser and spindle motor stop.

The player automatically re-starts when it receives a command from the computer or a
button on the player is pressed.

18



Software Installation

Before installing software

The supplied Setup disk contains the drivers for this product and the Audio Applications
software.
Before installing the software, make sure either of the following is installed.
eCard Manager (Card Services/Sccket Services) [supplied with your computer]
—When using a computer with PCMCIA card stot.
For more information about Card Manager, refer to your computer manual.
Even if a Card Manager is not installed and your computer has PCMCIA Controller
82365 100% compatible LSI, a program (ASPIS365.8YS) that will operate your
CD-ROM will be automatically instalted.
# ASPI Manager [mostly supplied with SCSI| board]
—When using a desklop computer with SCSI board.

¢ 1aydeyd

Note:
eYou may find it convenient to install the software directly onto your C drive (hard

disk).

System requirements

The Setup disk can be used only in an IBM or IBM compatible computer with a 3.5” floppy

disk drive.
System requirements:
For Notebook Computer
«|BM or IBM Compatible Computer
o PCMCIA Type [I Card Slot
PCMCIA Controller 182365 100% Compatible LS1 or
IBM Card Service (PCMCIA 1.07, 2.00) or
SystemSoft (PCMCIA 2.01, 2.10) or
Phoenix PCMPLUS (PCMCIA 2.00, 2.01, 2.10} or CardTalk
eWindows 3.1, 3.11 or Windows 95
0486 33 MHz or Faster Micro Processor
o4 MB of available Hard Disk Space
*8 MB of RAM Recommended
For Desktop Computer
#|BM and IBM Compatible Computer with SCS! Board including ASPI Manager
(Adaptec AHA-1542C, Future Domain TMC-1670, etc.)
sWindows 3.1, 3.11 or Windows 95

asem)os Buijeisul asojeg/uQ Jamod

Notes:
#This product may not be compatible with the notebook computer which has a built-in

sound system device.
o|f no sound is listened after the software installation under Windows 95, change
“Preferred device” setting of Muftimedia in Control Panel.

19



Software Installation

Making back-up copy

Betore installing software, it is recommended that you make a back-up copy by referring to
your computer's manual and store the original in a safe place.

Installing under Windows 3.1, 3.11

Make sure that you have connected the player to your computer (& P. 15, 17) and bath
the player and your computer are turned on (17 P. 18).

Note:
o The desktop computer user who does not have a PCMCIA card slot can not install
the Audio Applications software.

Start Windows 3.1, 3.11.
Insert the supplied Setup disk into drive A (or B).
Select “Run...” from the File menu of the Program Manager.

Type A: (or B:\SETUP and press (Enter).
"CD-ROM Criver Setup” window appears.

Click (Continue).

The following window appears.

CB-ROM Diiver Setup

Choose the desired epcration by selecting a button:

A L WN =

' Driver Instaiiation Install drivers.

" Configure System Configurc drivers.
Appifcation ostatiation | Install audio applications.

Exit the Installation program.

#If you want to install the drivers, go to next step.

®|f you want to change the previous settings, select “Configure System™ and follow the
instructions on computer.

#[f you want to install Audio Applications software, select “Application Installation” and go
to step 10 & P. 23).

&|f you want to exit the install program, select “Exit” and follow the instructions on
computer.

20



Software Installation

Click (Driver Installation).
“Driver Installation” window appears.

Driver tnstallation

If you want ta install the software in a diflerent directory,
type the name of the directory below.

Destination Directory:

|

o 1 [ EBat ]

The default directory is MCDRM. If you want to install the driver in a different
directory, type the directory name and go to next step.

2 iaydeyd

Click (OK).

The following window appears.

Briver Installalion

Select the button for the type of card installation you want.

l; ‘Autommtic Configuration l Have Setup chose the card settings.

|§' Custom Configisration I Chaose the card zettings yourself,

Exih ) ] Exit the Installation program.

sUnless you need to configure the card settings yourself, select "Autornatic
Configuration” to install the hardware driver.

o|f you encounter problems after installing software, select “Custom Configuration™
and change the settings.

o|f you want to exit the install program, select “Exit” and follow the instructions on
computer.

LI'E FL°E SMOPUIAL Japun alemyos Buljelsy)
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Software Installation

Click (Automatic Configuration)
After copying files, the following message appears.

Driver Instailation

All files have been successhulty copled.

The CONFIG.SYS, AUTOEXEC.BAT and SYSTEM.IN! will be
modifled.Their current tiles will be seaved as CONFIG.KME,
AUTOEXEC.KME and SYSTEM.KME.

9 Click (OK]

“CD- HOM Drlver Setup” wmdow appears.

CD-ROM Driver Setup

Sottware Installation Complete

Aftee thig Ingtallation, please remave the floppy disk and restart
your compuler.  If there arc any problem, please refer to
*Troubleshoating’, *Errar Messages® ar "README File' in your
Operaling Instructions.

@ WO Address was sel as: 240
-
Intetrupt wes scl s 5
Eﬂ:wmunn instaiation | [ AcstatComputer | [T ExitProgam |

o!f you want to install the Audio Applications software, go to next step.
e|f you want to exit the instalt program, select "Exit Program”, exit the Windows,
remove the Setlup disk and then restart your computer.

22



Software Installation

1 0 Click (Application Installation].

11

“Application Installation” window appears.

Application Installation

Setup will install the audio applicati in the following
directory.

H you want to install the software in a ditferent direclory, type
the name of the directory below.

Destination Directory:

Expcaunior 7]
T ) [

The default directory is PCAUDIOZ2. If you want to install the Audio Applications
in a different directory, type the directory name, and go to next step.

Z 121deyd

Click (OK).

The following window appears.

Application Installation

Select the bution lor the installation you want.

Install all Avdio applications.
[Requires XXX K Bytes of space.]

' Cystem Instaitatien Choose which appiications to Install.
Exit the installstion program.

“Complete Instailation

olf you want to install all Audio Applications software, go to next step.

o|f you want to select some Audio Applications, select "Custom Installation” and
foltow the instructions on computer.

e|f you want to exit the install program, select “Exit” and follow the instructions on
computer.

LL'E ‘1€ SMOPUIAL 19pun aiemyos Bujeisuj
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Software Instaliation

1 Click (Complete Installation].
After copying files, “CD-ROM Driver Setup” window appears.

CD-ROM Driver Setup

Softwarc | lation C

After this Installation, please remove the flappy disk, and restan
ynut :nmpul:r I1 there nre any pmhlem please referto

bl , 'Edror ges’ or ‘AEADME File' In your
Operallng Instml:lmns

¥2

e

1 3 Remove the Setup disk and click {Restart Computer].

After installing the software if you start Windows, you are ready to enjoy your
applications including the Audio Applications. For details about the audio
application’s operation, refer to the “Audio Applications Operation” (& P. 30~49).

/" Insertion/Removal with Power On (For DOS/Windows 3.1, 3.11) I
If your computer has a Card Service and ASPISMGR.SYS is being used,
Sound/CD-ROM Interface Card can be removed or inserted from/into the PCMCIA
card slot of computer without turning off your computer.

However, when you start running your computer, make sure that Sound/CD-ROM
Interface Card is inserted into the PCMCIA card slot and the player is on. If
ASPI3365.5SYS and ASPISDBK.SYS are being used, Insertion/Remaoval with power
on is not possible.

Note:
& |f your computer has more than one slot, and if you want to re-insert the Sound/CD-
K ROM Interface Card, make sure to insert it into the same slot it was inserted before. ./

24



Software Installation

Installing under Windows 95

Under Windows 95, if the PC Card (PCMCIA) device is setup as 16-bit Driver, the system's
stability may be affected and speed may become slower.

Please follow the steps below to make sure that PC Card (PCMCIA) device of Windows 95
is setup as 32-bit Driver.

Before performing the following instructions, please do not insert the Sound/CD-ROM
Interface Card into the PCMCIA card slot.

1 Turn on your computer. Windows 95 automatically starts.

P Click (Start), point to Settings and then click the Control Panel icon.

Z 4a1dey)

3 Double-click the PC Card (PCMCIA) icon.

4 A If the *‘PC Card (PCMCIA) Wizard” appears, follow these
instructions to setup the 32-bit Driver.
@ Select “No” and then click (Next>).
@ Select “No” and then click (Next>).
@ Click (Finish). “System Setting Change” window will appear.
O Click to exit Windows 95.
@ Restart your computer. The 32-bit Driver will be setup and go to step 5.

4B If the “PC Card (PCMCIA) Properties’ appears and the 32-bit
Driver has been setup, click (Cancel), and go to step 5.

5 Make sure that the Interface cable is connected to the Sound/CD-
ROM Interface Card and to the player. Turn on the player (= P. 18)
and then insert the Sound/CD-ROM Interface Card to your computer’s
PCMCIA card slot (1z P. 15, step 4).

“New Hardware Found” window appears only when the inserted card has not
previously registered in Windows 95.

@  Click (OK).
“Driver from disk provided by hardware manufacturer” is selected and “install
From Disk” window appears.

G6 SMOPUIA/LL'E 1L'E SMOPUIAL J3pun aiemyos Buijjelsu|

7  nsert the supplied Setup disk into drive A (or B), and click (oK.
“New Hardware Found"” window appears again.
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8 Click (OK).

“Install From Disk” window appears again.

9 Click {OK).

“New Hardware Found"” window appears again.

1 0 Click {OK).

“Install From Disk” window appears again.

11 Click {OK).

The initial screen appears and the driver has been installed.
1 2 Remove the Setup disk.

Using the Sound Recorder and Volume Control
under Windows 95

You do not need to install Audio Applications Software under Windows 95,

Please use the Sound Recorder and Volume Control in your Windows 85, in the following

cases,

ewhen you adjust the computer sound of CD-ROM and the sound of an audio CD played
back with the player,

®when you record, store and playback voice, music and FM sound on your computer.

To start the Sound Recorder or Volume Control, click {Start), point the Programs, point the

Accessories, point the Multimedia and then click the Sound Recorder or Volume Control.

Notes:

olf the volume of Mic leve! is set too high, the built-in speakers may howl. Please
lower the Microphone volume or the player's VOLUME control.

elUse “Line-In" in the Volume Control window to adjust the volume and stereo
batance, and controls the sound of audio CD inserted in the player or the audio
source connecled to LINE IN jack of the player.

*When you play the audio source connected to the LINE IN jack of the player while
playing audio CD with your computer connected to the player, the speakers give
priority to the audio source.

o The Adjust volume for “Others” in the Properies of Volume Control and “CD Audio™,
“AuxB" and “PC Speaker” in the dialog box can not be used by this product.

Plug & Play (for Windows 95)

Windows 95 supports Plug & Play function as the new feature.

This Sound/CD-ROM Interface Card supports this feature. You can plug/remove this
card in/from your computer. When you turn on your computer, Windows recognizes
and sets up your hardware automatically.
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Inserting a CD

To insert a CD, follow the instructions below.

Close the disc cover.

Place a CD onto the center
spindle.

Note:
elnsert CD with the disc's
label facing up.

1 Press [% to open the
disc cover and then raise it.

Note:

¢To transport the player, remove the CD and slide the Lock switch toward the rear
of the player, otherwise the disc cover may open and the player or the CD may get
damaged.

Removing a CD

To remove a CD, follow the instructions below. Make sure that a blinking message
*“BUSY” does net appear on the player's display, and the Lock switch is not slid
toward the rear of the player.

3 Close the disc cover.

2 Carefully remove the CD by
lifting it.
Note:
#®Replace the CD in its original case.

switch

OPEN

1 Press () to open the
disc cover and then raise it.
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Using the Player with a Computer

After the software installation (I#° P. 19), you are ready to play game/photo/audio/video
CODs.

Playing a CD-ROM

When connected to a notebook/desktop computer which has PCMCIA card slot, you can
listen to the computer scund of CD-ROM with the built-in speakers.

e|n order to hear the sound files of Multimedia titles, the desktop computer needs to have
a Sound board, such as Sound Blaster [Creative Technology Ltd.], etc., instatlled.

oTo play VIDEO CD or CD-l, commercial MPEG Boards [REAL Magic LITE {SIGMA
DESIGNS Ltd.} is recommended] is required on the computer side.

Note:
&5Some CD-ROMs are soundless.

Playing an audio CD

To operate audio CDs from the computer, install audie CD contro! software (not sup-
plied}.

For DOS users
eOnly after running Windows 3.1, 3.11, if you install audio CD control software, you can
listen to an audio CD with the built-in speakers or the PHONES jack.

For Windows 3.1, 3.11 users
® Use the Media Player in Accessories.
If it is not available, be sure 10 add “[MCI] CD Audio” at Drivers in Control Panel.

For Windows 95 users
e Use the Media Player or CD Player in Multimedia folder.
If they are not available, be sure to add "Add/Remove Programs” in Control Panel.

Note: - - -
eWhile playing an audio CD with your computer, buttons O O O and

L ¥

(T onthe player cannot be used.



Using as a Personal Audio CD Player

If you are using batteries, you can listen to music under stable conditions, without the AC
adaptor. 't is recommended not to play an audio CD while walking or jogging.

If you want to play an audio CD without disconnecting from your computer, be sure to open
and close the disc cover after you start running Windows 3.1, 3.11 before playing to
guarantee the player’s buttons function properly.

Caution:
o[t is not safe to listen to headphones while driving a car.

Be sure the VOLUME control is set to 2~4 hefore playing an audio CD.
1 Insert an audio CD (= P. 27).

2 Press POWER switch to
turn on the player.

=N ACHG

3 Press ().

While operating audio CDs, the
foliowing display appears.

S,‘ ﬂﬂﬂﬂ +~—1Elapsed time
i

]
4 Adjust the VOLUME control. Audio CD’s track number

¢ Jo1deyd

Note:
eYou can listen to the music with the built-in speakers or your headphones (nol
supplied) connected into the PHONES jack.

Button Function

R ARG

Starts/pauses playing an audio CD.

Skips to the next track by pressing once.

Continues skipping tracks if you hold down.

Returns to the beginning of the track being played by pressing once.

Jamndwon e yum Jake|d ayy Buisn

Skips to the previous track by pressing once when the elapsed time is 00:00.

1afkeld @9 oipny |euosiad e se buisn)

Continues reversing tracks if you hold down.

Os| Ot OiU

Stops playing an audio CD.
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Introduction

Under Windows 3.1, 3.11 only, the Audio Applications enable you to record, store, and
playback voice, music, and FM sound on your computer. These applications are designed
to enhance communication and improve productivity by incorporating audio into your daily
use of the computer.

B Audio Applications Overview
(for Windows 3.1, 3.11 user only):

The following table shows the Audio Applications and each function.

lcon Application Function
name
7 Volume Regulates the volume and stereo balance of the built-in
E\@) Control speakers or headphones connected to the PHONES jack.
. Combines signals from multiple sources for built-in
Mixer speakers or headphones connected to the PHONES jack.
Audio Records, stores and playbacks voice, music, and FM
@ Recorder sound in wave ((WAV) tile format.
Extended Records, stores and playbacks voice, music and FM
Recorder sound like the Audio Recorder. Records and stores audio
files directly to the hard disk unlike the Audio Recorder.
Recording Regulates the recording leve! and sterec balance of
Contro! multiple sources for a recording application.
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| Volume Control

The Volume Control enables you to regulate the volume and stereo balance. You can use
the Volume Control with the Audio Recorder during playback. if you are playing multiple
sources, you can use the Mixer to combine them, with the Volume Control as a master
regulator.

| Starting the Volume Control

Open the Audio Applications program group and double-click the Volume Control
icon,
or

from the Audio Recorder Options menu or the Mixer menu, select the Volume

Control command.

The Volume Control window appears.

| Using the Volume Control Window | |

Yol ¢ I— Stereo balance bar
Adjusts the stereo balance of the built-in speakers or headphones
connected to the PHONE jack by sliding this bar left or right.

Qutput level bar
Adjusts the volume of the built-in speakers or headphones
connected to the PHONE jack by sliding this bar up or down.

Mute button
Turns the sound off/fon by clicking this button.

B Menu Commands:

Command Description
Always On Top Displays the Volume Control on top of other windows.
Mixer Displays the Mixer window if you want to mix the playing
of sounds from several sources.
Help Displays information about how to use the Velume Control.
About Volume Control Gives the version number and copyright information,
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Bl Mixer

The Mixer enables you to combine signals from several audio sources during playback,
with control over the volume and stereo balance of each source.

When you use the Audio Recorder to play an audio file, you can open the Mixer to combine
the audio from the file with audio from other sources,

The Volume Contro! works in tandem with the Mixer. The Volume Control acts as a master
regulator of the combined signal from the Mixer.

| Starting the Mixer |

Open the Audio Applications program group and double-click the Mixer icon,
or
select Mixer from the Audio Recorder Options menu or the Velume Control menu.

The Mixer window appears.
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Mixer

| Using the Mixer Window

Notes:

olf the volume of Mic level is set too high, the built-in speakers may howl. Please
fower the Mic volume or the player's VOLUME control.
#When you play the audio source connected to the LINE IN jack of the player while
playing audic CD with your computer connected to the player, the speakers give

priority to the audio source.

Stereo balance bar
Adjusts the stereo balance of a
source by sliding this bar left or
right.

Output level bar
Adjusts the volume of a source I

by sliding this bar up or down.

Mute button

R e

Turns offfon the audio from any
source by clicking this button.

Line

Adjusts the volume and the stereo balance, and
controls the sound of audic CD insernted in the player or
the audio scurce connected to LINE IN jack of the player.

B Menu Commands:

Menu

Description

Always On Top

Displays the Mixer on top of other windows.

Volume Control

Displays the Volume Control at the left side of the Mixer.

Help

Displays information about how to use the Mixer.

About Mixer

Gives the version number and copyright information.

| Adding the Volume Control

The Volume Control serves as a master control to the Mixer. To display the Volume Control
window, select Volume Control from the menu.
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& Audio Recorder

The Audio Recorder enables you to record, store and playback voice, music, and FM
sound. It provides settings for sound attributes such as mono/stereo, format and sampling
rate. You can use it to embed sound objects in documents created in applications that
support object linking and embedding (OLE). The Audio Recorder's record, edit and
playback capabilities are compatible with the Windows Sound Recorder and other record-
ers that record and playback in the PCM format.

The Audio Recorder can record to and playback from wave (WAV) file formats.

| Starting the Audio Recorder |

Open the Audio Applications program group and double-click the Audio Recorder
icon.

The Audic Recorder window appears.

' Using the Audio Recorder Window ]
The lengthofa [= Audia Recoeder - (Untitled) Py [
selected pan of File Edit Pptions Effects Help ~ Menu bar (w P. 35)
the current audio CEM R RES) —————— Toolbar ([&& P, 37)
fil d)— b Gt 0B T T T fheee Tl T L ;
ile {second) o S i N ,“mz—-————r& Total lime (second)
. L .
Mono (normal) ‘"—*—": Sampling rate
or Stereo (kilohertz)
Shows the waveform
A of the current audio
: 3] file @@ P. 39)
Wil vy e ja
¥
[
STOP button

Stops recording/playback by clicking this button.

PLAY button
Starts playback by clicking this button.

RECORD button
Starts recording by clicking this button.
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B Menu commands:

The following table shows the menus and each description on Menu bar.

Menu Command Description
File New Creates a new audio file. When you start the Audio
Recorder, a new file is created automatically.
Open Loads an existing audio file.
Save ' Stores the current audio file to disk under its existing file
name.
Save As Allows changing the name of the audio file before

saving it. Selecting this command displays the Save As
Sound File dialog box.

Revert Restores the previously saved version of the current
audio file.

Properties Displays the Properties dialog box, from which you can
see and change properties of the current audio file.

b -

Exit Closes the Audio Recorder window. g

Edit Undo Reverses the last change you made to the current )
audio file. D

Cut Removes the selected audio portion and stores it on the g
Clipboard. %

Copy Copies the selected audic portion to the Clipboard -
without removing it.

Paste Inseris the Clipboard audio at the cursor, pushing other g.)
material ahead. If an audio portion is selected, the o
clipboard audio will be replaced with the selected audio =1
portion. 2

Paste Mix Mixes the Clipboard audio with the audio beginning at &
the cursor,

Delete Removes the selected portion of the recording. To

recover a deleted sound, use the Undo command
immediately after using Delete.

Mute Silences the selected portion cf the audio file, reducing
the amplitude of that portion of the waveform to zero.
To recover a muted sound, use Undo immediately after
using Mute.

Select All Select the entire audio file.
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Menu Command Description
Edit ZoomIn Displays a smaller unit of time.

Zoom QOut Displays a larger unit of time.

insert File Displays the Insert File dialog box. From here you select
an audio file to be inserted into the current file at the
cursor. If audic is selected, the inserted audio file
replaces the selected audio. The inserled file will take on
the properties of the host file.

Mix with File Displays the Mix With File dialog box. From here you
select an audio file to be mixed with the current file,
beginning at the cursor.

Options *' | Auto Repeat Repeats the file endlessly when play is pushed.

Volume Control | Adjusts the whole volume of the sound being played.

Recording Mixes audio from several sources in a recording.

Control

Mixer Combines audio from several sources during playback.

Always On Top | Displays the Audio Recorder on top of other windows.

Effects *2 { Normalize Amplifies the selected audio to the maximum volume
possible without distortion.

Volume Increases or decreases the amplitude of the selected
audio by 25%.

Speed Changes the selected audio to be 100% faster or slower.

Fade Causes the selected audio to Fade In from silence to its
highest amplitude, or Fade Out from its highest amplitude
to silence.

Echo Dispiays the Echo Rate dialog box. From here you set
the echo delay and echo volume for the selected audio.

Reverse Flips the selected audio backwards, so the end becomes
the beginning and the beginning becomes the end.

Help Contents Displays a list of topics you can select for information on
the Audio Recorder features.

About Audio Gives the version number and copyright information.

Recorder

*! Options menu commands enable you to display the Volume Control, Recording Control,
and Mixer windows.

*2 Effects commands change the waveform of the audio you have selected. If there is no
selection, the entire file is affected. To change the audio back to what it was before you used
an Effects command, select Undo from the Edit menu before using any other command.
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B Toolbar:

For your convenience, eight often-used menu commands are also available as toolbar
buttons at the top of the Audio Recorder window. Here is the meaning of each button.

New

Cut Copy Paste Mix
| Making a Recording N
Note: .

sWhile making a recording if the volume of Mic level is set too high or the Record
Monitor in the Recording Control is set to on, the built-in speakers may howl. Please
lower the Mic volume or the players VOLUME control.

The following recording procedure is for one time recording. Whenever you want to make
a recording, perform the following steps.

Select New from the File menu.
The Sound Attributes dialog hox appears.

2 Select settings for Sampling Rate, Stereo {on [<] or off(]), and Format,

C Sound Attributes ' |
oo B
131 kHz 12} — _
—: Stereo
Foimat:
PCM 8 bit 3
P 8 b
PCM 16 bit
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Audio Recorder

eSelect one of the PCM (uncompressed) formats if you want the highest sound
quality, or if you wish to edit or modify the recording with Effects commands before
you save it.

3 Click (OK), [ @ ] and speak into the microphone or turn on the line-in
source.

4 Click [ W ]to end the recording.

®Once you have clicked [ B ], you must perform steps 1~4 for any subsequent
recording.

5 Select Save As from the File menu.
The Save As dialog box appears.
In the Save As dialog box, select a directory location and type a name for the audio
file, and click Read Only if you want to save the file as read only. This prevents the
accidental recording over of a file at a later date.

You can use the Recording Control window to regulate the mix of audio from several
sources. To display this window, select Recording Controi from the Options menu. If you
do not open the Recording Control window, the Audio Recorder uses the source setlings
used previously. See the Recording Control section for more information (& P. 48).
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| Playing an Audio File |

1 Load an audio file into the Audio Recorder.
It can be a recording you have made, or use the Open command (File menu) to load
a file stored on disk.

D Click [ » | to hear the audio file.
The file will play to the end unless you interrupt it by pressing [l ],

- Audio Recorder - RINGIN.WAY +* [ -]

[g— Zooms out the wavetorm by
clicking 1.

T bm bw be hm bm bw b= 18— Zooms in the waveform by

clicking | . >
[EIC e ]e= = g
| 5
Shows more of the waveform behind Shows more of the waveform ahead 2
. o . s ®
the current display by clicking «. the current display by clicking —-. 9
2
o
B Other functions for playing an Audio file: %
Function Operation o
Playing a portion of the audic file | Select the portion in the waveform display by using g
the mouse, then click [ »_|. o
=
Canceling the selected portion Click anywhere in the waveform display. o
Selecting the entire audio file Double-click anywhere in the waveform display. &
Regulating the sound level/stereo | Use Volume Control from the Options menu
balance (= P.31).
Playing with other sound sources | Use Mixer from Options menu (@& P. 32).
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Editing an Audio File

Use the Qpen command (File menu) to load an audio file from disk to the Audio Recorder.
You can also edit a file you just recorded.
The following table shows the functions and each operation for editing an Audio File.

Function Operation
Deleting an audio 1. With the mouse, select the portion of the audio data to be
section deleted.

2. Press (Del), or select the Delete command. The selected
audio disappears, joining the audio before and after it. If you
wish to save the deleted section, use the Cut command
instead of Delete.

To restore a deleted audio section, select Undo before making
any other changes to the audio file.

Muting an audio 1. Select the wavetorm of the audio to be muted.

section 2. Select Mute from the Edit menu. The selected audio is

silenced; it is reduced to a flat line.

To restore a muted audio section, select Undo before making
any other changes to the audio file.

Moving/copying an 1. Select the portion of the audio data to be moved or copied.

audio section 2. Click the Cut button to erase the selected audio and place it

on the Clipboard, or click the Copy button to leave the
selected audio as is while copying it to the Clipboard.

3. Piace the cursor where you want the Clipboard material to
appear and click the Paste button.

To restore a moved/copied audio section, select Undo before
making any other changes to the audio file.

Recording new audio | 1. Place the cursor at the end of the waveform display, or play
and placing it on the the file to the end.

Clipboard 2. With inpul the source(s) ready, click [ @ to record new

material. Click [ W |to finish.

3. Use the mouse to select the section just recorded, then click
the Cut or Copy button to put that audio section onto the
Clipboard.
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Function

Operation

Inserting audic from
the Clipboard

1. Place the cursor at the point in the waveform display where
you want to insent audio from the Clipboard.

2. Click the Paste button. The Clipboard audio waveform
appears at the cursor. No audio is erased.

To restore an inserted audio section, select Undo before
making any other changes to the audio file.

Replacing the selected
audio with Clipboard
audio

1. Use the mouse to select the waveform of the audio to be
replaced.

2. Click the Paste button. The Clipboard audic appears in
place of the selected audio.

To restore a replaced audio section, select Undo before
making any other changes to the audio file.

Mixing Clipboard
audio with the
selected audio

1. Place the cursor at the beginning of the audio to be mixed,
or select a section of audio to be mixed.

2. Click the Paste Mix button. The Clipboard audio is
combined with the audio after the cursor. If a section of
audio was selected, the Clipboard audic is combined with
the selected audio until the end of either the Clipboard or -
the selected audio.

To restore a mixed audio seclion, select Undo before making
any other changes to the audio file.

inserting audio file, or
replacing a selected
audio segment with
audio file

1. Place the cursor at the point in the waveform display where
you want to insert an audio file, or select the audio you
want to replace with an audio file.

2. From the Edit menu, select Insert File to display the (nsert
File dialog box. Then select an audio file to insert into the
current file. If audio is selected, the inserted audio file
replaces the selected audio.

To restere an inserted/replaced audio section, select Undo
before making any other changes to the audio file.

Mixing audio from
a file

1. Place the cursor at the beginning of the audio to be mixed.

2. From the Edit menu, select Mix with File to display the Mix
With File dialog box. Then select an audio file to combine
with the current file, beginning at the cursor,

To reslore a mixed audio section, select Undo before making
any other changes to the audio file.
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Audio Recorder

W Editing audio file with Effects commands:

The Effects commands are described in the section “Menu commands” (& P. 36).
These commands alter the audio you have selected. If there is no selection, the entire file
is affected.

| Adding Sound to a Document ]

To embed audio files in documents follow the instructions below.

1 Open a document in the appropriate Windows application.

2 Load an audio file from disk to the Audio Recorder, or use an audio file
you just recorded.

3 Move the cursor to the icon at the top right of the Audio Recorder. The
cursor changes into a hand. Hold the mouse button and drag the icon
to the document window, then release the button at the place you want
the audio icon to appear.

4 To play an audio object in a document, double-click its icon.
You can also add audio to a document from the document’s application.
Place the cursor where you want the audio icon to appear, select the application’s

command for inserting an object, then select Audic Recorder in the list box. Refer to the
OLE section of Windows User Guide for more information.
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[ Changing an Audio File’s Properties

]

An audie file contains more than audio data. You can attach a title, description, and an icon

to an audio file.

Select Properties from the File menu.
The Properties dialog box appears.

o X
. pey

— =
T cm—— -

+

File Attsibat:
Size: 9K bytes
" 8 bit samples at 11 kHz

2 In this dialog box, place the cursor in the Label or Description area and
add or change the label or description for the audio file.

Click Plai }to hear the audio file.

The Audio Recorder assigns a default picture of the Audiodrive logo to each audio
file. To select your own icon for a given sound file, click the Set Picture button. The

Set Picture dialog box appears.

From here, select the picture to appear with the audio file. It can be any graphic
contained in a bitmap (.BMP or .DIB), wave { WAV), icon (.iCQ), executable (.EXE) or

library (.DLL)} file.

The picture you select will appear in the Audio Recorder. It will also appear in any

document in which you embed the audio file.

3 When you are finished, click (0K).
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Extended Recorder

The Extended Recorder is designed as a tool for recording meetings and dictation. Like the
Audio Recorder, the Extended Recorder enables you to record, store, and playback voice,
music, and FM sound. Unlike the Audio Recorder, the Extended Recorder records and
stores in real-time to your hard disk. Your recording time is limited only by the amount of
hard disk space you have available.

The Extended Recorder can record to and playback from PCM which is the Microsoft
Windows audio file format.
The Extended Recorder provides a choice of linear PCM (8 or 16 bits).

B System requirements:

Recording or playing back with a high sampling rate on the Extended Recorder can be a
lot of work for your computer's CPU. A lower sampling rate and/or number of bits can
produce a more than adequate recording without overtaxing your system.

It you wish to use 16-bit stereo at 44 kHz for recording or playback, we recommend that
your computer have the following capabilities:

®a 486 DX with an internal clock speed of 50 MHz or more
8 MB RAM or more
san average hard disk access time of 15 ms or faster

Computers without these capabilities may slow down drastically or lose data if you attempt
16-bit stereo, 44 kHz recording or playback.

LStarting the Extended Recorder ]

Open the Audio Applications program group and double-click the Extended Re-
corder icon.

The Extended Recorder window appears.

To expand the window so it shows more information, select Expanded View in the Options
menu,
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| Using the Extended Recorder Window |

Here is the expanded view of the Extended Recorder window.

- Extended Recorder n
FEile Optlons Help ——— Menu bar (@& P. 45, 46)
= ——— Toolbar (i P. 46)
T ——1— Current location
‘| (second)
Aud:anve Total length (second)
[ onn[secl—F I OKB——1— Length (kilobyte)
L N N T kHz M""‘CL?_?E — . Sample rate, mono
[ | Free Pisk Space : 16300 KB, 24: 31 33[mm ss} .| {monaural) or stereo and

sound format (bit)

Free disk space and
recording time available

STOP button
Starts playback by clicking this button.

PLAY button
Starts playback by clicking this button.

Current file’'s name

RECORD button
Starts recording by clicking this button.

B Menu Commands:

Menu Command Description

File New Creates a new audio file. When you start the Extended
Recorder, a new file is crealed automatically. New opens
the Sound Attributes dialog box, enabling you to set the
sampling rate, mono or stereo, and sound format,

Open Displays the Open dialog box, from which you can select an
audio file to bring into the Extended Recorder.

Save As Saves the audio file with the name and in the focation you
specify. You can also select to save the file as read only.

Exit Closes the Extended Recorder,
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Extended Recorder

Menu Command Description

Options Auto Repeat |Repeats the lile endlessly when play is pushed.

Temp. File Enables you to set the directory location for the temporary
Directory file that the Extended Recorder creates while recording.
When you save an audio file, this temporary file is copied to
the name and location you specify.

Voice Displays the Voice Activation dialog box and pauses the
Activation recording when there is no input from the recording source,
To turn voice activation on, click the Pause Recording
After check box, then set the Seconds of Silence field. The
recording will pause after the number of seconds of silence
set in the Seconds of Silence field. Recording will resume
when sound from the recording source resumes.

Expanded Displays the expanded window.

View
Help Contents Displays a list of topics you can select for information on the
Extended Recorder features.
About Gives the version number and copyright information.
Extended
Recorder

B Toolbar:

For your convenience, five often-used menu commands are also available as toolbar
buttons at the top the Extended Recorder window. Here is the meaning of each button,

New Open

K A
¥ W]

Expanded View

e*When the Expanded View is selected, (normal View) is diaplayed.
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Extended Recorder

| Making a Recording ]

Note:

oWhile making a recording if the volume of Mic level is set too high or the Record
Monitor in the Recording Control is set to on, the built-in speakers may howl. Please
lower the Mic volume or the player's VOLUME control.

The following recording procedure is for one time recording. Whenever you want to make
a recording, perform the following steps.

1 Select New from the File menu.

New opens the Sound Attributes dialog box, where you can set the sample rate, the
sound format, and whether to record in mono or stereo. After you sel the aftributes,

click (OK).

Click[_®_J, and speak into the microphone or turn on the line-in source.

3 Click [m_|to end the recording.
*Once you have clicked [ B ], you must perform steps 1~3 for any subsequent
recording.

4 Select Save As from the File menu.
In the Save As dialog box, select a directory location and type a name for the audio
file, and click Read Only if you want to save the file as read only. This prevents the
accidental recording over of a file at a later date. Click to save it.

Reference:
Use Volume Control (@& P. 31), Mixer @& P. 32) or Recording Centrol (t# P. 48) to
regulate the sound level of recording or playback.
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fii Recording Control

The Recording Control enables yéu to regulate the recording level and stereo balance from
multiple sources. You can use the Recording Control with the Audio Recorder or Extended
Recorder during recording.

| Starting the Recording Control

Open the Audio Applications program group and double-click the Recording Control
icon,

or
from the Audio Recorder or Extended Recorder Options menu, select the Recording
Control command.

The Recording Control window appears.
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Recording Control

| Using the Recording Control Window |

The Recording Control displays recording level and stereo balance controls for each of
your computer's available hardware sources.

Master
Adjusts the overall gain
and balance of a mix.

Stereo balance bar
Adjusts the stereo
balance of any

source by sliding
this bar left or right.

Line, Mie, Synth
Selects a recording source (Line, Mic or Synth)
by clicking the circle in front of it's name.

Rzcording Control

Recording level bar

o (F* Record Monitor

Adjusts the recording
level of a source by
sliding this bar up or
down,

Note:

[
Record Monitor

Monitors recording in progress
by clicking this circle.

Line
Adjusts the recording level and the stereo balance, and
controls the sound of audio CD inserted in the player or
the audio source connected to LINE IN jack of the player.

eWhen you play the audio source connected to the LINE IN jack of the player while
playing audio CD with your computer connected to the player, the speakers give
priority lo the audio source.

B Menu Commands:

Command

Description

Always On Top

Displays the Recording Control on top of other windows.

Help

Displays information about how to use the Recording
Control.

About Recording Control

Gives the version number and copyright information.
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Error Messages on Computer

| When installing the software

Message

Solutien

The directory you typed is invalid.
Please type a full path with drive letter;
for example “CAMCDRM".

Use less than eight characters.

Use only valid characters (refer to the DOS
manual).

Could not find the file : [Filename]
Please type in the directory to look for
this file.

File indicated in [Filename] is not found,
Set the directory containing this file,

PCMCIA Controller is not found.
You can install only drivers.
Do you continue this installation?

Make sure that your computer has
PCMCIA slot.

Make sure that connection between your
computer and card slot board has been
made properly.

You cannot install Audio Applications
software onto a desktop computer which
does not have PCMCIA card slot.

{ When restart the computer after installing software

Refer to the following items of the README File (= P.51).

1. ASPI Manager
2. CD-ROM Device Driver
3. MSCDEX.EXE
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README File

The README File on the supplied Setup disk contains additfonal information on system
Iroubleshooting and it is copied to the hard disk (normally to CAMCDRM) during installa-
tion, except Windows 95.

ASP! Manager

CD-ROM Device Driver

MSCDEX.EXE

Error Messages when installing software
Sample CONFIG.SYS Files

I/O Base Address

. Supplemental Troubleshooting Guide

Mo b=

Read or print this file if you have difficulty in installing the CD-ROM drive.

| Viewing the README.TXT File in DOS ]

1 At the DOS prompt (C:\), type MORE <\MCDRM\README.TXT

9 Press (Enter).

| Viewing the README.TXT File in Windows 3.1, 3.11

Double-click the Notepad icon of Accessories.
Select “Open’ from the File menu.

Double-click the directory name.
{Normally it is C:\MCDRM)

4 Select the file name “README.TXT".

5 Click (OK).
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README File

| Viewing the README.TXT File in Windows 95

When installing under Windows 95, README File is not automatically copied to the hard
disk. To view the file, follow the instructions below,

1 Double-click the My Computer icon.

2 Insert the supplied Setup disk.

3 Double-click the 312 Floppy icon.

4 Double-click the Readme icon.
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Troubleshooting

When trouble occurs, check the following points before returning the player for service.

appears on the
display.

Trouble Possible Cause Solution
Turn on the AC adaptor is not plugged into | Plug in the AC adaptor
POWER switch, the outlet or DC IN jack correctly (& P. 11).
but nothing correctly.

The alkaline batteries or
rechargeable battery are/is not
installed correctly, or dead.

Install the alkaline batteries/
rechargeable battery properly,
charge the rechargeable
battery or replace with new
batteries (& P. 11~14).

AC adaptor is con-
nected/recharge-
able battery or
alkaline batteries
is/are installed, but
buttons/POWER
switch of player do
not function.

Press RESET switch located at
the bottom by using a pointed
object like a pen.

Disc cover can not
be opened.

The Lock switch is slid toward
the rear of the player.

Slide the Lock switch to
opposite direction.

The optional
rechargeable
battery runs down
too soon.

The rechargeable battery
capacity has been reduced and
the battery life has been
shortened by being charged too
often after using for short
periods.

Refresh the rechargeable
battery (& P. 13}. I the
battery runs down quickly even
after refreshing, replace with
new one.

The optional
rechargeable
battery can not be
charged.

AC adaptor is not connected,
the rechargeable battery is not
installed or POWER swilch of
the player is not on.

Connect the AC adaptor, install
the rechargeable battery

(& P. 11) or tumn on the
POWER switch of the player.

The data of
CD-ROM is not
transmitted to
your computer.

The Interface cable or
Sound/CD-ROM Interface Card
is not connected to the player
or to the computer properly.

Properly connect the Interface
cable or Sound/CD-ROM
Interface Card (@ P. 15).

The SCSI cable is not
connected to the player or to
the desktop computer properly.

Properly connect the SCSI
cable.

There are duplicate SCSI ID
numbers in computer system.

Set different SCSI ID number
for each device in your system

(@ P. 59).
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Troubleshooting

or broken.

Trouble Possible Cause Solution
The data of The software is not installed Instail the software correctly
CD-ROM is not correctly, (= P.19)
transmitied to The Intertace cable pinis bent | Contact an Authorized
your computer.

Panasonic Service Center.

The terminator switch of the
player is set to OFF.

Turn the terminator switch ON
(= P.59).

The dust (ex. hair) lies on the
center spindie.

Remove the dust from the
center spindle.

Transmission
speed of data

Using the alkaline batteries/
rechargeable battery with

Use the AC adaptor.

CD-ROM Player.

slows down. computer,
The notebook computer has Set the CPU speed of the
entered the power management | notebook computer faster in
mode. power management or use the
AC adaptor.
Windows 95 The Sound/CD-ROM Interface | After turning on the player,
computer does not | Card is not fully inserted, or the | open the My Computer,
recognize player is not turned on. Control Panel, System and

then Device Manager and click
“Refresh”.

“no diSC”
message appears
on player’s display
even after inserting
a CD.

Sound skips, or
data can not be
read.

CD is placed with the label side
facing down.

Place the CD with the label
side facing up (= P. 27).

CD without (ﬂﬁ%"@ or [ﬂﬁgm

DeRTAL & 100

mark is used.

Use the CD marked with
G o G

CD may have become dirty.

Clean the CD (& P. 60).

CD is damaged.

Replace with another CD.

The player or/fand CD are damp
or moist, because the player
orfand CD may be moved from
a cold place to a warm place.

Remove the CD from the
player and do not use the
player and CD for 1 hour.
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Troubleshooting

Trouble

Possible Cause

Solution

You cannot listen
to sound with the
built-in speakers.

The player’'s VOLUME control
is set to “0”.

Set the player's VOLUME
control to a higher level.

The player's volume is set to
the lowest level or Mute is
selected in the Volume
Control/Mixer application.

Set the player's volume to a
higher leve! or turn off the Mute
in the Volume Control/Mixer
application & P. 31, 32).

Headphones are connected.

Disconnect the headphones
(& P.29).

You cannot listen
to the audio data,
except for CD-DA,

The Interface cable is not
connected to the player's
Sound interface connector

Properly connect the Interface
cable to player's Sound
Interface connector

with the built-in properly. (= P.15).
speakers.
When playing The audio system device is Disconnect the audio system

audio CD on your
computer, you can
not listen to the
audio CD inserted
in the player with
the built-in
speakers.

connected to the LINE IN jack
of the player.

device from the player
(= P. 26, 33, 49).

You cannot record
using Microphone.

Microphone is not connecled to
the MIC jack properly.

Connect the microphone to the
MIC jack properly (@ P. 16).

Volume of Mic is set to the
lowest level or Mute is selected
in the Recording Control
application.

Set the volume of Mic to a
higher leve! or turn off the Mute
in the Recording Control
application (& P. 48).

Speakers howl,

The volume of Mic level is set
too high, or the Record Monitor
is on.

Lower the volume of Mic lavel,
off the Record Monitor in
Recording Control appiication
(= P. 4B) or lower the player's
volume.
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Details of Setup Disk Software

| About the installation copy ]

Setup disk contains the following programs (€, € and €). When installing the software,
programs @ and € are copied entirely. However, in case of program €, only one file (@,
® or &) is copied, depending on your hardware condition (& table below)}. Installation
will automatically choose @), & or @).

© ASPIManager

File Condition

@ ASPISMGR.SYS when your computer has both Card Service and
' Socket Service.

(& ASPISDBK.SYS when your computer has only Databook CardTalk.

© ASPIS365.5YS when your computer has neither Card Service nor
' Socket Service.

@ CD-ROM Device Driver
KMECD.SYS

@ Microsoft MS-DOS CD-ROM Extensions
MSCDEX.EXE

| Options for ASPI Manager (for sophisticated users) |

Each file of ASPI Manager has the following options.

ASPISMGR.SYS
DEVICE=<path>\ASPISMGR.3YS [/PORT=<|/O base address>]
[/SOCKET=<slot No.>]/INT=<IRQ leve!>][/ADLIB][/BOFF]

® ASPISDBK.SYS
DEVICE=<path>\ASPISDBK.SYS [/PORT=<//O base address>]
[/SOCKET=<slot No.>J[/INT=<IRQ level>]/MEM=<base address>]
[/ADLIB}

(© ASPIS365.8SYS
DEVICE=<path>\ASPIS365.5YS [/PORT=<I/Q base address>]
[/SOCKET=<slot No.>)[/INT=<IRQ level>][/MEM=<base address>]
[/ADLIB][/i365RST]
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Details of Setup Disk Software

/PORT=XXX

Since the I/O port is needed for the Sound/CD-ROM Interface Card, add
this line and specify the base address at XXX using a hexadecimal
number. The Sound/CD-ROM Interface Card occupies 32 bytes of space
starting with the specified base address.

The factory setting is 240h(ASPISDBK.SYS is 280h). If the specified
address is already being used, specify another base address from the
following addresses. Also, depending on the computer, the I/O port may
need to be specified in the Card Manager (ASPISMGR.SYS,
ASPISDBK.SYS). Refer to your computer manual.

220 240 260 280 (220h, 240h is not available in ASPISDBK.SYS)

/SOCKET=X

When you are using a personal computer with more than two PCMCIA
card slots, add this line and specify the slot at X, where you are inserting
the Sound/CD-ROM Interface Card. If you specify 0 or you don't specify
the slot, the ASPI Manager searches all slots, and uses the first available
slot.

/ADLIB

ADLIB 388h-38Bh will be opened as second I/O port.

/INT=X

For IRQ, you may select: 3, 5, 7 or 10(A).

This option sets the IRQ leve! of the Sound/CD-ROM Interface Card
using a hexadecimal number. The factory setting is 5. Make sure this
number does not conflict with another device. The IRQ level is not set
without this option. If you're using the SystemSoft Card Service, choose
a number from the “IRQ=" entries in the CSALLOC.INI file.

MEM=XXX

Option effective with ASPISDBK.SYS and ASPIS365.5YS only. Add this
line and specify the memory space’s base address to read the card
informaticn by the segment address (hexadecimal number). You need to
exclude this specified address in the EMS “X” option so that it will not
overlap the region of EMS. If you don't specify the base address, CEQOQ is
applied, and 8 KB of memory from CEQQO to CFFFF is used.

/BOFF

Option effective with ASPISMGR.SYS only. Setting this option turns off
the beep sound that is generated when inserting or removing the
Sound/CD-ROM Interface Card.

/I365RST

Option effective with ASPIS365.5YS only. After setting this option,
PCMCIA controller chip (i82365) should be reset.
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Details of Setup Disk Software

Options for Microsoft MS-DOS CD-ROM Extensions

The format of the MSCDEX program in the AUTOEXEC.BAT file is as follows:

MSCDEX [/V /K /E] /D:[DriverName] /L:[Driveletter] /M:[Value]

/N Displays the list of additional information including how much memory is used by
buffers, resident data and resident code.

/K Type this only when the CD-ROM media directory is written in Kanii (Japanese).

{E  Expanded memory (EMS) is usable if this is available in your system. This
conserves about 16 KB of main DOS memory.

/D:[DriverName]
Driver name is a required parameter 10 communicate with the CD-ROM drive. The
internal name of KMECD.SYS is PCMCIACD, and should be substituted for
[DriverName).

f.:[DriveLetter]
Drive letter is an alphabetic character assigned to a CD-ROM drive. If there is more
than one CD-ROM drive, the alphabetic characters are sequentially assigned star-
ing with the entered drive letter. If no drive letter is entered, next available alphabetic
character is assigned.

If you assign except A~M for Driveletter, you must change the DOS LASTDRIVE
statement. tn your CONFIG.SYS file, add a line like this:

LASTDRIVE= [:]:I

Type the alphabetic character {(N~Z) assigned to the
last valid drive that DOS may use.

M:[Value]
MSCDEX allocates the memory as sector buffers for caching CD-RCM information.
If no buffer size is entered, 10 buffers each of which uses 2048 bytes of memory will
be allccated.

For exampie, to install MSCDEX with an internal name of PCMCIACD, use expanded
memory, and configure the CD-ROM drive as drive H, enter:

MSCDEX /E /D:PCMCIACD /L:H
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SCSI ID Number and Terminator

B SCS!ID number:

Each SCSI device connected to your computer system has an individual |D number (refer
to the respective manuals). Be sure that the CD-ROM SCSI ID number does not conflict
with another SCS| device connected to the computer system. Normally personal
computer's SCSI ID number is setto 7.

The factory setting of the player's SCSI ID number is set to 5.

B Terminator:
Set the Terminator switch ON or OFF according to the player's condition.
ON: when the player is connected to the computer system.

OFF: when using as a personal audio CD player (power consumption can be
saved) (= P. 29).

The factory setting is ON.

| Setting ]

Set the 1D number switch (1~3) or Terminator switch (4) ON/OFF by using a pointed object
like a pen, and referring to the table below (for ID number).

{For SCSI 1D number setting)

lojeujwia) pue Jaquiny gl ISHS/aIemyos ysig dnyas Jo s|iejag

ID number switch
ID number

1 2 3

0 OFF | OFF | OFF

1 ON | OFF | OFF

2 OFF ON OFF

DIP switch 3 ON | ON | OFF

4 FF

N 0 OFF | ON
o Lap®aga |
6 OFF | ON | ON |
OFF1 7 2 3 a g
l 7 ON ON ON °
| Terminator . . (51

ID number switch  switch [: Factory setting

Example: ID number=5/Terminator=ON
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Maintenance

Player

Cautions:
®Do not use benzine, thinner, etc.
®Do not use commercial lens cleaner.

Clean the outside of the player with a Clean the lens with a dry cotton swab
soft, dry cloth. or a lens blower.

|.cD ]

Cautions:

*Do not use solvents such as benzine, record cleaners or anti-static spray for
records.

*Do not touch the signal side.
*Do not attach the labels to the disc.
®Do not write on the surface of disc with a pointed object kke a pen.

Wipe from the center to the edge
with a dry, soft cloth,
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Specifications

Operating Environment {under | Temperature: 5°C {41°F} to 35°C {95°F}
no damp or moist conditions): Humidity: 20% tc 85% RH

Storage Environment (under Temperature; —20°C {—4°F} to 55°C {131°F}

no damp or moist conditions): Humidity: 15% to 85% RH
Player:
Bimensions: 138 (W) %204 (D)X 35 {H) mm {5.52"x8.16"x1.4"}
Mass {Weight}: 0.5 kg {1.102 1bs.} (without batteries)
Power Source: Refer to the nameplate at the bottom of the unit.
Interface: PCMCIA/SCSI-2
Connector (SCS): Hall-pitch 50-pin
Buffer Size: 128 KB
Battery Life eWhen using Panasonic alkaline “AA” size batterieg
[at 20°C {68°F}: PHONES jack |Built-in speakers*!
Audio CD 4h 3h
CD-ROM 2h 1.5h

eWhen using the optional rechargeable battery
PHONES jack |Built-in speakers*

Audio CD 2h 1.5h
CD-ROM 1h 1h
Power Consumption: *When playing CD-ROM (with Sound/CD-ROM

Interface Card)
17 W [with AC adaptor]
*When player is off
2.5 W [with AC adaptor]

suonesyvads/asueusiuren

Data Transfer Rate 150 KB/s (Norma! Velocity mode}
(when using AC adaptor): 600 KB/s (Quad Velocity mode)

Access Time*? 143 stroke access time (Quad Velocity mode)
{when using AC adaptor): 295 ms typical
{The information is based Full stroke access time (Quad Velocity mode)
on the test results 540 ms typical

measured by Panasonic
internal test software.)

g s91deyn

*' Under the conditions of 30 mW+30 mW output.
*2 When using optional rechargeable battery or alkaline “AA” size batteries, the access
time may increase.
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Specifications

Player:
Compatible CD-ROM
Format:

Error Rates:

CD-ROM (Mode 1 and Mode 2 Form 1)
CD-ROM XA (Mode 2 Form 2)

CD-DA (CD)

Phote CD Multi-session
CD-| VIDEQ CD
Soft read errors

Hard read errors

Less than 10~°
Less than 102

Audio Performance:
Phones out (stereo );

Built-in speakers QOutput

Mic (Monaural) Input level:
Line in (stereo) Input level:

20 Hz~20 kHz

{without inserting Sound/

CD-ROM Interface Card)

S/IN More than 80 dB (A Range)
(without inserting Sound/
CD-ROM Interface Card)

Qutput level 0.6 Vrms

50 mVrms or lower {impedance 2 k{2 or higher)

1.2 Vrms or lower (impedance 30 k(2 or higher)

Frequency response

level: 0.3 W+0.3 W (impedance 4 Q)
Sound/CD-ROM Interface Card type Type 11
Card and Inteface Cable: Power source DC 5V, approximately
160 mA

Cable Length

Data transfer rate
Sound/CD-ROM interface
Card Dimensions 54 (W)x85.6 (D)5 (H) mm
{2.13"%3.37"x0.20"}

0.15 kg {0.331 Ib.}

375 mm (without connector)
7.0 MB/s (MAX.)

Mass {Weight}
(with cable)

Sound:
Number of quantization
bits:
Sampling frequency:
Sound source:

Software compatibility:

8 bit, 16 bit monaural/stereo recording

5.5, 8, 11.025, 22.05, 44.1 kHz (Selectable)

FM synthesis (YAMAHA OPL 3 compatible)
PCM (CODEC) {Recording and playing method)

®WAVE (recording/playback) and MIDI (playback)
performed using Windows-compatible audic
device driver

®Sound Blaster FM sound source for Windows and
Ad-Lib for DOS compatible
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End-User License Agreement
for
Microsoft® MS-DOS® CD-ROM Extensions

CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT
PRIOR TO OPENING THE PACKET. OPENING THE PACKET INDICATES YOUR AC-
CEPTANCE OF THESE TERMS AND CONDITIONS. If you do not agree to these terms
and conditions, return the unopened packet and the other components of the Panasonic
CD-ROM Sound Player to the place of purchase and your money will be refunded. No
refunds will be given for products that have an opened packet or missing components.

1. LICENSE: You have the non-exclusive right to use the one copy of the enclosed
Microsoft MS-DOS CD-ROM Extensions software program (“SOFTWARE") on a single
compuler used by single user. The SOFTWARE is in “use” on a computer when it is
loaded into temporary memory {i.e., RAM) or installed into permanent memory (i.e., hard
disk, CD-ROM, or other storage device} of that computer. However, installation on a
network server for the purpose of distribution to one or more other computers shall not be
granted.

2. COPYRIGHT: The SOFTWARE is owned by Microsoft Comoration or its suppliers and
is protected by United States copyright law, international treaty provisions, and al! other
applicable national laws. Therefore, you must treat the SOFTWARE like any other copy-
righted material (e.g., a book or musical recording} except that if the software is not copy
protected you may either (a) make one copy of the SOFTWARE solely for backup or
archival, or (b) transfer the SOFTWARE to a single hard disk provided you keep the
original solely for backup or archival purposes. All other copies of the SOFTWARE are in
violation of this Agreement. You may not copy the SOFTWARE manual(s) or written
materials accompanying the SOFTWARE, if any.

3. OTHER RESTRICTIONS: This agreement is your proof of license and must be re-
tained by you. You may not rent or lease the SOFTWARE, but you may transfer your right
under this License Agreement on a permanent basis provided you transfer this License
Agreement, all copies of the SOFTWARE and all written materials, and the recipient
agrees to the terms of this Agreement. You may not reverse engineer, decompile or
disassemble the SOFTWARE. Any transfer must include the most recent update and all
prior versions, if any. You will not export or re-export the SOFTWARE without the appropri-
ate Uniled States licenses (and foreign government licenses, if needed). Title and owner-
ship of the SOFTWARE shall remain with Panasonic and/or its suppliers.

4. TERM: This license is effective until terminated. You may terminate it by destroying the
SOFTWARE and related documentation and all copies thereof. This license will also
terminate if you fail to comply with any term or condition of the Agreement. You agree,
upon such termination, to destroy all copies of the SOFTWARE and related documenta-
tion.
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5. WARRANTY AND LIABILITY: NEITHER PANASONIC NOR PANASONIC'S SUP-
PLIER MAKES OR PASSES ON TO YOU OR OTHER THIRD PARTY, ANY WARRANTY
OR REPRESENTATION INCLUDING, BUT NOT LIMITED TOQ, THE IMPLIED WAR-
RANTY OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. NEI-
THER PANASONIC NOR PANASONIC'S SUPPLIER SHALL BE LIABLE FOR ANY
DAMAGE SUFFERED BY YQU INCLUDING, BUT NOT LIMITED TO, CONSEQUEN-
TIAL, SPECIAL OR PUNITIVE DAMAGES. THE ABOVE LIMITATIONS SHALL APPLY
REGARDLESS OF THE FORM OF ACTION WHETHER IN CONTRACT, TORT (IN-
CLUDING NEGLIGENCE}), STRICT PRODUCT LIABILITY CR OTHERWISE, EVEN IF
SUCH PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

6. NOTIFICATION: You are hereby notified that Microsoft Cerporation is a third-party
beneficiary to this Agreement to the extent that this Agreement contains provisions which
relate to your use of the SOFTWARE licensed hereby. Such provisions are made ex-
pressiy for the benefit of Microsoft Corporation and are enforceable by Microsoft Corpora-
tion addition to Panasonic.

7. U.S. GOVERMENT RESTRICTED RIGHTS: The SOFTWARE and documentation are
provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the U.S. Govern-
ment is subject 10 restrictions as sel forth in subparagraph (c) (1) (i) of the Rights in
Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs
{c) {1) and (2) of the Commercial Computer Software--Restricted Rights at 48 CFR
52.227-19, as applicable. Manufacturer is Microsoft Corporation/One Microsoft Way/Red-
mond, WA98052-6339, U.S,A. Subcontractor is Panasonic.

8. CONTROLLING LAW: This Agreement is govemed by the laws of the State of
Washington, U.S.A.
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SCSI ID number
SCSl interface connector
Setup disk
Software Installation
Sound/CD-ROM Interface

Card

SOUND interface connector . .

Specifications
STOP button
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Option

The following option is available through your local authorized parts distributor.

KXL-D30 Rechargeable Battery (Ni-Cd)

uondo/xepu|
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Panasonic Communications & Systems Company,
Computer Products Division

Division of Matsushita Electric Corporation of America
Two Panasonic Way, Secaucus, New Jersey 07094

Panasonic Sales Company

Division of Matsushita Electric of Puerto Rico, Inc.
San Gabriel Industrial Park, 65th Infantry Avenue KM. 9.5
Carolina, Puerto Rico 00630

Matsushita Electric of Canada Limited
5770 Ambler Drive, Mississauga, Ontario, L4W 2T3

Matsushita Electric Industrial Co., Ltd.
Central P.O. Box 288, Osaka 530-91, Japan

Printed in Japan PJQMAO133ZA F0296W0 [M]
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